Chapter 12

Assembly Modeling-1

Learning Objectives

After completing this chapter, you will be able to:
* Create bottom-up assemblies.

* Add mates to assemblies.

* Create top-down assemblies.

* Move individual components.

* Rotate individual components.
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ASSEMBLY MODELING

An assembly design consists of two or more components assembled together at their respective
work positions using parametric relations. In SolidWorks, these relations are called mates.
These mates allow you to constrain the degrees of freedom of the components at their
respective work positions. To start the Assembly mode of SolidWorks, invoke the New
SolidWorks Document dialog box and choose the Assembly button, as shown in Figure 12-1.
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Figure 12-1 The New SolidWorks Document dialog box

Choose the OK button to create a new assembly document; a new SolidWorks document will
be started in the Assembly mode and the Begin Assembly PropertyManager will be invoked,
as shown in Figure 12-2.

Types of Assembly Design Approaches

In SolidWorks, assemblies are created using two types of design approaches, the bottom-up
approach and the top-down approach. These design approaches are discussed next.

Bottom-up Assembly Design Approach

The bottom-up assembly design approach is the traditional and the most widely preferred
approach of assembly design. In this assembly design approach, all components are created as
separate part documents, and then they are placed and referenced in the assembly as
external components. In this type of approach, the components are created in the Part mode
and saved as the .sldprt documents. After creating and saving all components of the assembly,
you need to start a new assembly document (.sldasm) and insert the components in it using
the tools provided in the Assembly mode. After inserting the components, you can assemble
them using the assembly mates.
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Figure 12-2 The Assembly mode with the Begin Assembly PropertyManager

The main advantage of this assembly design approach is that the view of the part is not
restricted because there is only a single part in the current file. Therefore, this approach
allows you to concentrate on the complex individual features. This approach is preferred
while handling large assemblies or the assemblies with complex parts.

Top-down Assembly Design Approach

In the top-down assembly design approach, the components are created in the same assembly
document, but saved as separate part files. Therefore, the top-down assembly design approach
is entirely different from the bottom-up design approach. In this approach, you will start
your work in the assembly document and the geometry of one part will help in defining
the geometry of the other.

Note
F?EMJ You can also create an assembly with a combination of the bottom-up and top-down assembly
S wpproaches.

CREATING BOTTOM-UP ASSEMBLIES

As mentioned earlier, the bottom-up assemblies are those in which the components are created
as separate part documents in the Part mode. After creating the components, they are inserted
in the assembly and then assembled using the assembly mates. To start an assembly design
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with this approach, you first need to insert the components in the assembly. It is recommended
to place the first component at the origin of the assembly document. By doing this, the
default planes of the assembly and the part will coincide and the component will be in the
same orientation as it was in the Part mode. When you place the first component in the
assembly, that component will be fixed at its placement position. The techniques used to
place the components in the assembly file are discussed next.

Placing Components in the Assembly Document

In SolidWorks, there are various options to place the components in the assembly. These

options are discussed next.

Placing Components Using the PropertyManager

CommandManager:  Assemble > Insert Components

Menu Bar: Insert > Component > Existing Part/Assembly

Toolbar: Assembly > Insert Components

[—m=] Whenyou start a new SolidWorks document in the
|F_r% Assembly mode, the Begin Assembly
~ PropertyManager will be displayed, as shown in
Figure 12-3. Note that this PropertyManager will be
displayed only when you start a new assembly document.
The Message rollout in the Begin Assembly
PropertyManager prompts you to select a part or an
assembly and then place the component in the graphics
area or to choose the Create Layout button to create the
top-down assembly. When you choose the Browse button
in the Part/Assembly to Insert rollout, the Open dialog
box will be displayed. Browse to the location where the
component is saved and then select the component and
choose the Open button. The cursor will be replaced by
the component cursor and the graphic preview of the
component will also be displayed. The name of the selected
component will be displayed in the Open documents
selection box of the Part/Assembly to Insert rollout. It is
recommended to align the origin of the first component
with the assembly origin. To place the component origin
on the assembly origin, choose the OK button from the
Begin Assembly PropertyManager.

To place the other components in the assembly document,
choose the Insert Components button from the Assemble
CommandManager; the Insert Component
PropertyManager will be displayed. Choose the Browse
button from the Part/Assembly to Insert rollout. Select

the component from the Open dialog box; the cursor will be replaced by the component
cursor and the preview of the component will also be displayed in the drawing area. Left-click

anywhere in the drawing area to place the component.
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Figure 12-3 The Begin Assembly
PropertyManager
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If the component to be inserted is opened in another window, then it will be listed in the
Open documents selection box of the Begin Assembly PropertyManager or the Insert
Component PropertyManager. You can insert the component by selecting and dragging it
to the drawing area. To preview the selected component, expand the Thumbnail Preview
rollout.

The Start command when creating new assembly check box in the Options rollout of the
Begin Assembly PropertyManager is selected by default. So, the Begin Assembly
PropertyManager is invoked automatically when you start a new SolidWorks assembly
document. The Graphics preview check box in the Options rollout is also selected by default
and is used to display the graphic preview of the component selected to be inserted.

Tip. 1o place multiple components or multiple instances of the same component,
\e A choose the Keep Visible button at the top of the Begin Assembly PropertyManager
4 and select the placement points in the drawing area to place the multiple components.

Starting an Assembly from the Part Document

Menu Bar: File > Make Assembly from Part
Toolbar: Menu Bar > New > Make Assembly from Part/Assembly

= Youcanalso start an assembly document from the part document. If the part document

| _ﬁa of the base component of the assembly is opened, choose New > Make Assembly
— from Part/Assembly from the Menu Bar toolbar or choose File > Make Assembly
from Part from the Menu Bar menus. If the New SolidWorks Document dialog box is invoked,
choose the OK button from this dialog box; an assembly document will be started and the
Begin Assembly PropertyManager will be invoked. Choose the OK button from this
PropertyManager to place the component at the origin.

. Note

; ~ If you invoked the New SolidWorks Document dialog box last time in the Novice mode, the
Begin Assembly PropertyManager will be displayed while creating an assembly from a part
document. If you invoked the New SolidWorks Document dialog box last time in the Advanced
mode, you first need to select the assembly template and then choose the OK button. When you
choose the Make Assembly from Part/Assembly button and if a SolidWorks warning box is
displayed, choose No from the warning box. The New SolidWorks Document dialog box will
be displayed in the advanced mode.

Placing Components Using the Opened Document Window

Another most widely used method of placing components in the assembly is the use of currently
opened part documents. For example, if the assembly that you need to create consists of
three components, open the part document that you want to insert and then start a new
assembly document. Close the Begin Assembly PropertyManager. Now, choose Window >
Tile Horizontally or Tile Vertically from the Menu Bar menus; all SolidWorks document
windows will be tiled horizontally or vertically, depending on the option chosen.

You need to place the first component in the assembly document, at the origin. If the origin is
not displayed by default in the assembly document, choose Hide/Show Items > View Origins
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from the Heads-up View toolbar. Now, move the cursor on the component in the other
window. Press and hold the left mouse button on the name of the component in the
FeatureManager design tree and drag the cursor to the assembly origin in the assembly
window, as shown in Figure 12-4. When the coincident symbol appears below the component
cursor, release the left mouse button. If the Mate pop-up toolbar is displayed, choose the
Add/Finish Mate button to place the component in the assembly. Similarly, place the other
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Figure 12-4 Placing a component in the assembly file by dragging from an existing window

Tip. When you insert a component in the assembly, it will be displayed in the
FeatureManager design tree. The convention of naming the first component is
() Name of Component <1>. In this convention, (f) denotes that the component
is fixed. You cannot move a fixed component. You will learn more about the fixed
and floating components later in this chapter. Next, the name of the component
will be displayed. The <1 > symbol denotes the serial number of the same component
i the entire assembly.

The (-) symbol before the name of the component implies that the component is
Sloating and under-defined. You need to apply the required mates to the component
to fully define it. You will learn more about assembly mates later in this chapter.
The (+) symbol implies that the component is over-defined. If no symbol appears
before the name of the component, then the component is fully defined.



Assembly Modeli

ng-I 12-7

components in the assembly. If another existing assembly document is opened, you can also
drag and drop the part from that assembly document.

Placing Components by Dragging from the Windows Explorer

You can also place components in the assembly document by dragging them from the Windows
Explorer. Open Windows Explorer and browse to the location where the part documents are
saved. Tile the Windows Explorer window and the SolidWorks window such that you can view

both the windows.

Move the cursor on the icon of the part document in the Windows Explorer.

Press and hold the left mouse button on it, then drag the cursor to the assembly document
window. Release the left mouse button at the origin of the assembly document to coincide the
origin of the part with that of the assembly document. Figure 12-5 shows the part being

dropped in the as

sembly window.

2 pdf_specification
2 Pragram Files
0 project_repart_vivek
2 Solidworks Diata
2 zolidwarks 2008_manuscripts
1) beta_tials
1) oM _solidworks 2008 042407
112 e02_solidworks 2008 080307
1) eN3_solidworks_2008_0G0307
112 cid_solidwarks_ 2008 _0R0707
112 c0f_solidworks 2008081207
112 c0B_solidworks_2008_ 062207
12 07 _salidwarks_2008_070807
112 c08_solidworks_2008_071907
112 c03_solidworks_2008_072607
112 c10_saildworks_2008_080307

112 e11_solidworks_2008_ 080507
112 c12_solidworks_2008_ 080907
1) angle_constraint
) Benchice
1) multi-mates
) Patterrbased-mate
1) Pipe_Vice
125 Plummer_Block
) test
53 test]
1) tool vice
5 top-down-assembly
1[5 tor_reference
() sw_2008_pi
3116
1 VIVEK SINGH
D-R Drive [E:)

% BenchVice =101 x| fEselidWorks W O-F-H-2-9-.-8 = - Assemd = 2 - - O %X
File Edit Wiew Favortes Tools  Help ‘ :,-'

; = = % 119 2] ED)] B W g2

- N =, 113 l
O Back ~ | - ? | P | Search 1 Folders ‘ E' Insert Mate  Linear Smart Maove show Assembly Refarence | New 5
E ( nt Components Compon... Fasteners Component| Hidden | Features Geometry | Motion

Address () c12_salidworks_2008_080907\Benchvice 7| [£] G - - - Components  ~ - Study

= x K@f; 2 || Assemble [ Tayoul | Skeich | Evaluste | Office Products | -8 x
3 Page Maker Libray =] ) B » VT E (S B B [
1 pagemaker_libram (T~ ]

test. SLDASM

@ Assemd (Default <Display State-1
IE Annotations

%} Front Plane

-5 Top Plane

@ Right Plame

I_. Crigin
il mates
vice-body SLDDRW
|
4
vice-body SLDPRT

vice-jaw. SLODRW

v

et :

vicejaw SLOPRT —4 | ¥l “Trimetric
| Model [ MotionStudy1l |

ontrol Panel =
A " I_I

= | Sulidwiorks 2008 | lunder Defined | [Editing Assembly | | [Z]

Figure 12-5 Dropping the part from Windows Explorer to the assembly window

Tip. Only the information about the mates is stored in the assembly file. The feature
information of parts is stoved in the individual part files. Therefore, the size of the
assembly file is small.

It 1s recommended that all parts of an assembly should be saved in the folder in
which the assembly is saved. If you do not save the parts and the assembly in the
same folder, the part will not be displayed in the assembly and it will show errors.
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Placing Components from the Internet Explorer

You can also place the components from Internet Explorer. You need Internet Explorer 4.0
or a later version. Browse to the location of the SolidWorks part file link on the Web. Drag
the hyperlink and drop it in the drawing area of the assembly document; the Save As dialog
box will be displayed. Save the part document at the desired location.

Placing Additional Instances of an Existing Component in the Assembly
Sometimes you need more than one instance of the component to be placed in the assembly
document. To do so, press and hold the CTRL key on the keyboard. Now, select the component
in the FeatureManager design tree and drag the cursor to the location where you want to
place the instance of the selected component. Release the left mouse button to drop the
new instance of the component. Similarly, you can place as many copies of the existing
component as you want by following the above mentioned procedure.

Assembling Components

After placing the components in the assembly document, you need to assemble them. By
assembling the components, you can constrain their degrees of freedom. As mentioned earlier,
the components are assembled using mates. Mates help you to precisely place and position
the component with respect to the other components and the surroundings in the
assembly. You can also define the linear and rotatory movement of the component with respect
to the other components. Additionally, you can create a dynamic mechanism and check its
stability by precisely defining the combination of mates. There are two methods for adding
mates to the assembly. The first method is using the Mate PropertyManager and the second
is using the Smart Mates. Both these methods are discussed next.

Assembling Components Using the Mate PropertyManager

CommandManager:  Assemble > Mate %hﬁ%
Menu Bar: Insert > Mate Cep |
Toolbar: Assembly > Mate >

| In SolidWorks, mates can be applied using the Mate PropertyManager. Choose the
_ %) ‘ Mate button in the Assemble CommandManager or choose Insert > Mate from the
Menu Bar menus; the Mate PropertyManager will be invoked, as shown in Figure 12-6.

Select a planar face, curved face, axis, or a point on the first component and then select
the entity from the second component; the selected entities will be highlighted. The names
of the selected entities will be displayed in the Entities to Mate selection box of the Mate
Selections rollout. The Mate pop-up toolbar will be invoked, as shown in Figure 12-7. The
most suitable mates to be applied to the current selection set are displayed in the Mate
pop-up toolbar. Also, in the Standard Mates rollout of the Mate PropertyManager, the
most appropriate mate is selected, by default. The preview of the assembly using the most
appropriate mate is displayed in the drawing area. You can also select the mates from the
given list of the mates that can be applied to the current selection set. As you select some
other mate from the Mate pop-up toolbar, the preview of the assembly will be displayed
using the newly selected mate. Now, choose the Add/Finish Mate button from the Mate
pop-up toolbar; the Mate PropertyManager will still be displayed, and you can add other
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mates to the assembly. After adding all the mates, choose the OK button from the Mate
PropertyManager. Various types of mates that can be applied are discussed next.

Coincident

| ,{l The Coincident mate is applied to make two planar faces coplanar. However,

#= | you can apply the Coincident mate to other entities as well. The details of the
geometries on which the Coincident mate can be applied are shown in

Figure 12-8.

When you choose the Coincident button from the Mate pop-up toolbar, the preview of
the model will be displayed according to the current selection of the mate. Also, the
model will be assembled in the aligned or the anti-aligned direction, depending on the
current orientation of the model. You can modify the orientation of the assembled
component by choosing the Aligned or the Anti-Aligned button from the Standard
Mates rollout. You can also choose the Flip Mate Alignment button from the Mate
pop-up toolbar to modify the mate alignment. Figure 12-9 shows the faces to be selected
to apply the Coincident mate. Figure 12-10 shows the resulting mate applied with the
Anti-Aligned button chosen. Figure 12-11 shows the Coincident mate applied with the
Aligned button chosen.
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Figure 12-10 The Coincident mate applied with Figure 12-11 The Coincident mate applied with
the Anti-Aligned button chosen the Aligned button chosen
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Concentric
|®| The Concentric mate is used to align the central axis of one component with
=1 that of the other. You need to select the circular faces or circular edges to apply
the Concentric mate. You can also apply the Concentric mate between a point
and a circular face or a circular edge. The other combinations for applying the Concentric
mate are displayed in the table given in Figure 12-12. For applying a Concentric mate,
invoke the Mate PropertyManager. Select circular faces or edges from two different
components; the names of the selected entities will be displayed in the Entities to Mate
selection box. The Concentric button will be chosen, by default in the Mate pop-up
toolbar. If this button is not chosen by default, you need to manually choose it. The
preview of the models being assembled, after applying this mate, will be displayed in the
graphics area. You can choose the Aligned or the Anti-Aligned button on the basis of the
design requirement. Finally, choose the Add/Finish Mate button from the Mate pop-up
toolbar.

Second Companent

ASSEMBLY

MATE
COMEINATIONS o | B |, =] \g§1 R £
{USING COMCENTRIC MATE) | 5 E 5 5 | B E“J ER =N 5]
B = T B R
cylinder |+ v v v v v | K| K| R | K
Sphere | K [+ |+ |+ |+ | X | X | X | X | X
Cone | v IV K v XK KK

Circular,”

Firet Alro Edge K v ¥ X | X |¥v X | X = r
Component Line v v | K| K || KIK|IXK| R
Point |+ v | K| K |v ] X[ X ¥ [ XX
Extrusien | ¢ | W | K KIKI K| K| KKK
surface | R K| KK K| K| K| K| K| K
Flane | ) | K| K| K| K| K| K| K| K| K

Figure 12-12 Tuable displaying the combinations for applying the Concentric mate

Figure 12-13 shows the faces to be selected to apply the concentric mate. Figure 12-14
shows the Concentric mate applied with the Aligned button chosen and Figure 12-15
shows the Concentric mate applied with the Anti-Aligned button chosen.

Distance
|HI The Distance button is chosen to apply the Distance mate between two
"'l components. To apply this mate, invoke the Mate PropertyManager and select
the entities from both components. Choose the Distance button from the Mate
pop-up toolbar; the Distance spinner will be displayed in the Mate pop-up toolbar. Set
the value of the distance in the Distance spinner. The preview of the assembly will be
updated automatically after you set the value of the distance. Use the Flip dimension
check box available below this spinner to reverse the direction of the mate. If needed,
you can choose the Aligned button or the Anti-Aligned button. Figure 12-16 shows the
combinations of components to apply the Distance mate. Figure 12-17 shows the faces to
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Face tobe
selected

Face to be
selected

Figure 12-13 Faces to be selected to apply the Concentric mate

Figure 12-14 The Concentric mate applied Figure 12-15 The Concentric mate applied
with the Aligned button chosen with the Anti-Aligned button chosen

be selected and Figure 12-18 shows the Distance mate applied between two components.

Angle
D | The Angle button is used to apply the Angle mate between two components.
| This mate is used to specify the angular position between the selected plane,
o planar face, or edges of the two components. To apply this mate, invoke the
Mate PropertyManager and select the entities from the two components. Choose the
Angle button from the Mate pop-up toolbar; the preview of the models will be modified
according to the default value of the angle. Also, the Angle spinner will be invoked and
you can set the value of the angle in this spinner. You can also change the angle direction
using the Flip Dimension button provided on the right of the angle spinner. You can
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Figure 12-16 Table displaying the combinations for applying the Distance mate

Face to be
selected

Figure 12-17 Selecting the faces to apply the Figure 12-18 The Distance mate applied to
Distance mate the selected faces

choose the Aligned button or the Anti-Aligned button on the basis of the design
requirement. After adding the mate, choose the Add/Finish Mate button from the Mate
pop-up toolbar. Various combinations for applying the Angle mate are shown in
Figure 12-19.

Figure 12-20 shows the faces to be selected to apply the Angle mate and Figure 12-21
shows the assembly after applying the Angle mate with the angle value of 90-degrees.

Parallel
| Q} | The Parallel button in the Mate pop-up toolbar is used to apply the Parallel
_* | mate between two components. To apply the Parallel mate, invoke the Mate
PropertyManager and select two entities from two components. Choose the
Parallel button from the Mate pop-up toolbar to apply the mate. You can also choose the
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Figure 12-19 Table displaying the combinations for applying the Angle mate

Facetobe
selected

\

Facetobe
selected

Figure 12-20 Faces to be selected to apply the Figure 12-21 Assembly after applying the Angle
Angle mate mate

Align button or the Anti-Aligned button. After applying the mate, choose the Add/
Finish Mate button from the Mate pop-up toolbar. Figure 12-22 shows the combinations
of components on which you can apply the Parallel mate. Figure 12-23 shows the entities
to be selected to apply the Parallel mate and Figure 12-24 shows the assembly after
applying the Parallel mate.

Perpendicular
f | The Perpendicular button in the Standard Mate rollout is used to apply the
|LJ Perpendicut b
— erpendicular mate between the two components. Invoke the Mate
PropertyManager and select two entities from two components. Choose the
Perpendicular button from the Mate pop-up toolbar. You can also choose the Aligned
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Figure 12-22 Tuable displaying the combinations for applying the Parallel mate

2

Faces to be
selected

Figure 12-23 Fuces to be selected to apply the

Parallel mate

button or the Anti-Aligned button. Choose the Add/Finish Mate button from the Mate
pop-up toolbar. Figure 12-25 shows the table displaying the combinations for applying
the Perpendicular mate. Figure 12-26 shows the entities to be selected and Figure 12-27

W 4

Figure 12-24 Assembly after applying the
Parallel mate

shows the Perpendicular mate applied to the assembly.

NS
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Figure 12-25 Table displaying the combinations for applying the Perpendicular mate

Faceto be

selected @

Face tobe
selected

Figure 12-26 IFaces lo be selected to apply the Figure 12-27 Assembly after applying the
Perpendicular mate Perpendicular mate

Tangent
(% | The Tangent button available in the Mate pop-up toolbar is used to apply the
|Q| Tangent mate between two components. To apply the Tangent mate between
two components, invoke the Mate PropertyManager and select two components.
Choose the Tangent button from the Mate pop-up toolbar. Figure 12-28 shows the
table displaying the combinations for applying the Tangent mate. Figure 12-29 shows
the entities to be selected to apply the Tangent mate and Figure 12-30 shows the Tangent
mate applied to the assembly.

Note

% | The Advanced Mates are discussed in the next chapter.

&)



Assembly Modeling-I 12-17

Second Component

ASSEMBLY
WATE

COMBIMATIONS
(USING TANGENT MATE)

Cane
Line
Faint
Flane
Cam

XX\\\xﬂﬂcwmder
PSSR PSR NA
XXX X XXX

Cylinder

"
Iphere |

Cone

First

P
Component one

Extrusion

Surface

*® b b \ \ wW | K \ Extrusion

R X I ] ] serere
IMMALJAYATA
XXX\\XX’\SMG%
X XK XX

%
K
Line | X
w
K
X

Cam

Figure 12-28 able displaying the combinations for applying the Tangent mate

—

Faceto be
selected

-0

\
T Face to be
selected

Figure 12-29 Entities to be selected to apply the
Tangent mate

Figure 12-30 Assembly after applying the
Tangent mate

Creating Multiple Mates

SolidWorks allows you to create multiple mates to a common reference. For example, refer to
the Base Plate shown in Figure 12-31. There are four Bolts to be assembled with the Base
Plate. After applying the Concentric mate, you need to apply a Coincident mate to the
bottom face of the heads of the Bolts and the top face of the Base Plate. You can apply all
these mates together using the Multiple mate mode option. To use this option, choose the
Multiple mate mode button available on the left of the Entities to Mate selection box in the
Mate Selections rollout. When you choose this button, the Common reference and Component
references selection areas will be displayed. The Common reference selection area will be
highlighted by default. Therefore, you need to select the common reference. In this case,
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select the top face of the Base Plate. As soon as you select the common reference, the
Component references selection area will be highlighted. Next, select the bottom face of the
head of one of the Bolts; the Mate pop-up toolbar will be displayed. You can select the
required mate type from this toolbar. Similarly, select the faces of the other Bolts to apply the
mate with the common face. Figure 12-31 shows the top face of the Base Plate selected as the
common reference and the four Bolts to be assembled. Figure 12-32 shows the assembly after
applying the Coincident mate to the bottom faces of the heads of all Bolts and the top face of
the Base Plate.

common hate Erit

Figure 12-31 ‘lop face of the Base Plate  Figure 12-32 Assembly after applying the
selected as the common reference Coincident mate between the Bolts and the Base Plate

The remaining options in the Mate PropertyManager are discussed next.

Mates
The Mates rollout is used to display the mates that are applied between the selected entities.

Options

The Add to new folder check box in this rollout is used to add the currently applied mate in
a folder. This folder is placed in the Mates mategroup in the FeatureManager design tree.
You can also drag and drop the other mates from the Mates mategroup in the newly created
folder. The Show popup dialog check box is selected by default and is used to display the
Mate pop-up toolbar. The Show preview check box is selected by default and is used to
display the dynamic preview of the assembly as you apply the mates to the components. The
Use for positioning only check box is used to define the position of the component only by
applying the mate. This mate is displayed in the Mates rollout, but when you exit the Mate
PropertyManager, this mate will not be displayed in the Mates mategroup in the
FeatureManager design tree.
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Assembling Components Using the Smart Mates

CommandManager:  Assemble > Move Component
Toolbar: Assembly > Move Component

Smart Mates is the most attractive feature of the
assembly design environment in SolidWorks. The
Smart Mates technology speeds up the design
process in the assembly environment of SolidWorks. To add
smart mates to the components, choose the Move
Component button from the Assemble CommandManager;
the Move Component PropertyManager will be displayed.
Now, choose the SmartMates button available in the Move
rollout; the Move Component PropertyManager will be
replaced by the SmartMates PropertyManager, as shown
in Figure 12-33.

8|

Also, the select cursor will be replaced by the move cursor.
Next, double-click on the entity of the first component to
add a mate; the component will appear transparent and the
cursor will be replaced by the smart mates cursor. Press and

o
Move R
E%i SmartMates

"I" IFree Drag j
Rotate ¥
Options ~

& standard Drag
¢ Collision Dekection

& Physical Dynamics

Figure 12-33 The SmartMates
PropertyManager

hold the left mouse button on the selected entity and drag the cursor to the entity with which
you want to mate the previously selected entity. The symbol of the constraint that can be
applied between the two entities will be displayed below the smart mates cursor. You can use
the TAB key to toggle between the aligned and anti-aligned options while applying Smart
Mates. When the symbol of the mate is displayed below the cursor, release the left mouse
button; the Mate pop-up toolbar will be displayed. Choose the Add/Finish Mate button from
this toolbar. Figure 12-34 shows the face to be selected to apply a smart mate and Figure 12-35

shows the component being dragged.

Faceto be
selected

Figure 12-34 Face to be selected to apply a smart  Figure 12-35 Component being dragged to apply

mate a smart mate
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When the smart mates cursor is placed near a circular face of the other component the
concentric symbol appears below the cursor, as shown in Figure 12-36.

Figure 12-36 Concentric symbol appears below the
smart mates cursor

Figure 12-37 shows a planar face selected to apply a Smart Mate. You can use the TAB key to
toggle between the aligned and anti-aligned mates. Figure 12-38 shows that the coincident
symbol appears below the cursor and Figure 12-39 shows the assembly after applying the
Coincident mate using the Smart Mate.

Figure 12-37 Planar face to be selected to apply Figure 12-38 Coincident symbol appears after
Smart Mates dragging the component near another planar face

Tip. You can also add Smart Mates without dragging the component. 1o add a
smart mate without dragging, invoke the Smart Mates tool. Double-click on the
entity of the first component; the component will be displayed as transparent. Now,
select an entity of the second component; the preview with the most appropriate
mate will be displayed and the Mate pop-up toolbar is invoked.
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Figure 12-39 The Coincident mate applied to
the assembly using smart mates

Note

| To apply smart mates without invoking the SmartMates tool, press and hold the ALT key and
select the first component. Drag the component to the entity of the other component to which you
need to apply the mate. As you release the left mouse button, the Mate pop-up toolbar will be
displayed. Choose the Add/Finish Mate button from this toolbar.

When you drag a component for applying a smart mate, the selected entity of the first component
will snap all corresponding entities of the second component. You can press the ALT key to exit
the snap. 1o enter the snap mode, press the ALT key again.

Geometry-based Mates

In the assembly design environment of SolidWorks, you can also add geometry-based mates.
Geometry-based mates are also a type of smart mates and are applied while you are placing
a component in the assembly environment. Consider a case in which the first component is
already placed in the assembly environment. Now, open the part document of the second
component. Choose Window > Tile Horizontal or Tile Vertical from the Menu Bar menus.

Suppose, you need to insert the revolved feature of the second component in the circular slot
of the first component and at the same time align the larger bottom face of the second
component with the upper face of the first component. To do so, press and hold the left
mouse button on the edge of the second component, as shown in Figure 12-40. Drag the
cursor to the assembly window near the upper edge of the circular slot of the first component;
the second component mated with the first component will be displayed in temporary graphics,
as shown in Figure 12-41. The coincident symbol will also be displayed below the smart mates
Cursor.

You can also toggle the direction of placement of the component. Figure 12-42 shows the
direction of placement flipped using the TAB key. Press the TAB key again to return to the
default direction. Release the left mouse button to place the component. On expanding the
Mates option from the FeatureManager design tree, you will notice that two mates are applied
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sl

Figure 12-40 Edge of the second component to be Figure 12-41 Component being dragged into

selected the assembly window for applying geometry-based
mates

to the assembly; one is the coincident mate and the other is the concentric mate. Figure 12-43
shows the assembly after adding the geometry-based smart mates.

>~ 3

Figure 12-42 The placement direction of component Figure 12-43 Assembly after adding a
is flipped using the TAB key geometry-based mate

Tip. You can add the geometry-based mates between two linear edges, two planar

faces, two vertices, two conical faces, two axes, between an axis and a conical face,
and between two circular edges.

Feature-based Mates

In the assembly mode of SolidWorks, you can also add feature-based mates. For adding
feature-based mates, one of the features of the first component must have a circular base or
a boss feature, and the second component must have a hole or a circular cut feature. The
feature can be an extruded or a revolved feature. Also, in the assembly document, one of the
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parts must be placed earlier. Open the part document of the component to be placed
using the feature-based mates and tile both document windows. In the FeatureManager design
tree of the part document, select the extruded or revolved feature and drag it to the assembly
window. Place the cursor at a location where you need to place the component. You can also
change the alignment or direction of placement using the TAB key. Release the left mouse
button to drop the component. Figure 12-44 shows the component being dragged by selecting
the revolved feature from the FeatureManager design tree of the part document. Figure 12-45
shows the resulting component assembled using the feature-based mates.
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Figure 12-44 Component being dragged by selecting the revolved feature
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Figure 12-45 Component assembled using the
feature-based mates

Pattern-based Mates
Pattern-based mates are used to assemble the components that have a circular pattern created
on the circular feature. The best example for these types of components is a flange or a shaft
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Tip. The feature-based mates arve applied only to the components having cylindrical
or conical features. You cannot add feature-based mates using features other than
cylindrical or conical geometry. If you are adding feature-based mates to a component
having a conical face, the second component also must have a conical face. You
cannot add a feature-based mate if the geometry of the feature of one component
is cylindrical and that of the other is conical.

If you ave adding feature-based mates using the features having conical geometry,
there must be a planar face adjacent to the conical face of both features.

coupling. Note that all components that will be assembled for creating pattern-based mates
must have circular pattern on the mating faces. To create pattern-based mates, select the outer
edge of the second component and drag it to the circular edge of the first component that is
already placed in the assembly document; the preview of the component assembled with the
first component will be displayed. Use the TAB key to switch the part with respect to the
pattern instances. Release the left mouse button to drop the part. Figure 12-46 shows the
component being dragged to the assembly document window. Figure 12-47 shows the preview
of the component being assembled and Figure 12-48 shows the component assembled using
pattern-based mates.
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Figure 12-46 Component being dragged to the
assembly document
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Figure 12-47 Preview of the component being  Figure 12-48 Component assembled using pattern
assembled using pattern-based mates based mates

Assembling Components Using the Mate Reference

CommandManager:  Assemble > Reference Geometry > Mate Reference
Menu Bar: Insert > Reference Geometry > Mate Reference
Toolbar: Reference Geometry > Mate Reference

|_ﬂm In SolidWorks, you can define the mate reference for |Gl

the part in the Part mode or in the Assembly mode. @ R
The mate references allow you to define the mating
references such as planar surfaces, axes, edges, and so on before
assembling the component.

b

Reference Mame

I Defaulk

Primary Reference Entity ~
To define the mate references, choose Reference Geometry > = |—

Mate Reference from the Assemble CommandManager; the
Mate Reference PropertyManager will be displayed, as shown | % [oefaul: R
in Figure 12-49. A [y -

The Mate Reference Name text box is used to define the name | secondary Reference Entity #
of the mate reference. The Primary Reference Entity rollout is L |

used to define the primary mate reference. The Mate Reference
Type drop-down list is used to define the type of mate. The % [ocfaut [
Mate Reference Alignment drop-down list is used to define the A Jany =l
type of alignment.

Tertiary Reference Entity A

The Secondary Reference Entity rollout is used to define the & ll:l
secondary mate reference and the Tertiary Reference Entity | ¢ [pefack =]
rollout is used to define the tertiary mate reference. A 3

w A =

Figure 12-49 The Mate
Reference PropertyManager

On adding the mate reference, you will notice that the
MateReference node will be displayed in the FeatureManager
design tree.

To assemble a component using the mate reference, you need to define the mate references
for two components. Also, the names of the mate references should be the same for both
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the components. After defining the mate references for both the components, place the
first component coincident with the origin in the assembly document. Now, drag the second
component in the assembly document. You will notice that the second component is aligned
to the references that were defined as mate references. Therefore, you do not need to apply
mates in the assembly environment.

Note

- As discussed earlier; when you place the first component in the assembly in the bottom-up assembly
design approach, it is fixed by default. Therefore, you cannot apply any mates to a fixed component.
10 add some mates to the fixed component, you first need to float the component. 1o do so, select
the component from the drawing area or from the FeatureManager design tree. Right-click
to invoke the shortcut menu and choose the Float option.

By default, the components placed afler the first component ave floating components. If you
need to fix a floating component, select the component and invoke the shortcut menu. Choose
the Fix option from the shortcut menu.

CREATING TOP-DOWN ASSEMBLIES

As mentioned earlier; the top-down assemblies are the assemblies in which all components
are created in the same assembly file. However, to create the components, you require an
environment in which you can draw the sketches of the sketched features and then convert
them into features. In other words, you need a sketching environment and a part modeling
environment in the assembly file. In SolidWorks, you can invoke the sketching environment
and the part modeling environment in the assembly document itself. The basic procedure
for creating the components in the assembly, or in other words, the procedure for creating
the top-down assembly is discussed next.

Creating Components in the Top-down Assembly

CommandManager:  Assemble > Insert Components > New Part
Menu Bar: Insert > Component > New Part
Toolbar: Assembly > Insert Components > New Part

(== Before creating the first component in the top-down assembly, you first need to save
| D | the assembly document. To do so, choose the Save button from the Menu Bar toolbar
~ after starting a new assembly document; the Save As dialog box will be displayed and
you will be prompted to save the parts internally or externally. It is recommended to save the
file externally. So, select the Save externally (specify paths) radio button and specify a new
folder to save the assembly file and the other referenced file in the same folder.

Now, choose Insert Components > New Part from the Assemble CommandManager; you
will be prompted to select the plane or face to position the new part. To create the base
feature, select the default planes; the Sketch CommandManager will be displayed with the
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Edit Component button chosen. This means that the part modeling environment is invoked
in the assembly document. Draw the sketch of the feature in the current sketching environment
and create the feature using the Features CommandManager. Save the part file and choose
the Edit Component button from the Features CommandManager to exit the part modeling
environment. The newly created component will have an Inplace mate with the default
assembly plane on which it was placed earlier. Therefore, the newly created component is
fixed.

Similarly, create the remaining features in the model. Whenever you create a component in
a top-down assembly, the component will be fixed using the Inplace mate. To delete this
mate, expand the Mates node in the FeatureManager design tree and select the Inplace
mate. Then, press the DELETE key; the Inplace mate will be deleted. Now, this component
is floating and you can move it. You can also assemble this component according to your
requirement. You will learn more about fixed and floating components later in this chapter.

MOVING INDIVIDUAL COMPONENTS

In SolidWorks, you can move the individual unconstrained components in the assembly
document without affecting the position and location of the other components. There are
three methods of moving an individual component. Two of these methods are discussed next.
The third method is discussed later in this chapter.

Moving Individual Components by Dragging

In the assembly environment of SolidWorks, you can move the component placed in an
assembly without invoking any tool. To move an individual component, select the component
and drag the cursor to move the component. Release the left mouse button to place the
component at the desired location.

Moving Individual Components Using the Move Component
Tool

CommandManager:  Assemble > Move Component
Toolbar: Assembly > Move Component

_=._| Youcan also move an individual component using the Move Component tool. Choose
E> the Move Component button from the Assemble CommandManager to invoke the

Move Component PropertyManager; the Free Drag option is selected from the Move
drop-down list in the Move rollout, by default. You will be prompted to select a component
and drag it. The select cursor will be replaced by the move cursor. Select the component and
drag the cursor to move the component. Release the left mouse button to place the component
at the desired location. The other options available in the Move drop-down list to move
the component are discussed next.

Along Assembly XYZ

The Along Assembly XYZ option in the Move drop-down list is used to move the component
dynamically along the X, Y, and Z axes of the assembly document. Select the Along Assembly
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XYZ option from the Move drop-down list; an assembly coordinate system will be displayed
in the drawing area and you will be prompted to select a component and drag the cursor
parallel to an assembly axis to move the component along that axis. Select the component
and drag the cursor to move the component along any one of the assembly axes.

Along Entity

The Along Entity option is used to move the component along the direction of the selected
entity. When you select this option, the Selected item selection box will be displayed. You will
be prompted to select an entity to drag along, and a component to drag. Select an entity to
define the direction to move the component; the name of the selected entity will be displayed
in the Selected item selection box. Now, select the component and drag the cursor to move
the component along the defined direction.

By Delta XYZ

The By Delta XYZ option in the Move drop-down list is used for moving the selected
component to a given distance in a specified direction. When you select this option, the
Delta X, Delta Y, and Delta Z spinners will be invoked and you will be prompted to select
a component and enter the distance in the PropertyManager. An assembly coordinate sys-
tem will also be displayed. Select the component to move and specify the distance in the
respective direction spinners. Choose the Apply button to move the component.

To XYZ Position

The To XYZ Position option is used to specify the coordinates of the origin of the part where
the component will be placed after moving. When you select this option, the X Coordinate,
Y Coordinate, and Z Coordinate spinners will be invoked and you will be prompted to select
a component and enter the X, Y, Z coordinates for the part’s origin. An assembly coordinate
system will also be displayed. Select the component and enter the respective coordinates of
the part origin in the spinners and choose the Apply button to place the component.

ROTATING INDIVIDUAL COMPONENTS

In SolidWorks, you can rotate an individual unconstrained component in the assembly
document without affecting the position and location of the other components. The Rotate
Component tool is used to rotate the component. There are three methods of rotating an
individual component. Two of these methods are discussed next and the third method is
discussed later in this chapter.

Rotating Individual Components by Dragging

You can rotate the component placed in the assembly without invoking any tool. To rotate
an individual component, select the component, press and hold the right mouse button and
then drag the cursor to rotate the component. Release the right mouse button after
attaining the desired orientation of the individual component.

Tip. You can toggle between the Move, Rotate, and SmartMates
PropertyManagers. Invoke the PropertyManager and then choose the Move,
Rotate, or the SmartMates button to invoke the corresponding PropertyManager.
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Rotating Individual Components Using the Rotate
Component Tool

CommandManager:  Assemble > Move Component > Rotate Component
Toolbar: Assembly > Rotate Component

[=x| You can also rotate an individual component using the Rotate Component tool. To
|@‘ rotate an individual component using this tool, choose Move Component > Rotate
-~ Component from the Assemble CommandManager; the Rotate Component
PropertyManager will be invoked. You will notice that the Free Drag option is selected from
the Rotate drop-down list in the Rotate rollout. Therefore, you will be prompted to select a
component and drag it to rotate. The select cursor will be replaced by the rotate cursor.
Select the component and drag the cursor to rotate the component. The other options in the
Rotate drop-down list are discussed next.

About Entity

The About Entity option in the Rotate drop-down list is used to rotate the component with
respect to a selected entity. The selected entity is defined as the rotational axis. When you
select this option, the Selected item selection box will be displayed and you will be prompted
to select an axis to rotate about. Select an entity to define the rotational axis; the name of the
selected entity will be displayed in the Selected item selection box. Now, select the component
and drag the cursor to rotate the component about the selected axis.

By Delta XYZ

The By Delta XYZ option available in the Rotate drop-down list is used to rotate the selected
component by a given incremental angle along the specified axis. When you select this option,
the Delta X, Delta Y, and Delta Z spinners will be enabled and you will be prompted to select
a component and enter the desired rotation in the PropertyManager. Select the component
to rotate and set the rotation angle in the respective spinners to specify the direction in which
you need to rotate the component. Choose the Apply button to rotate the component.

MOVING AND ROTATING INDIVIDUAL COMPONENTS
USING THE TRIAD

To move an individual component using the triad, you first need to select the component
and then right-click to invoke the shortcut menu. Choose the Move with Triad option from
the shortcut menu; the component will become transparent and the triad along with the
rings will be displayed on it. You can move the component using this triad and rotate the
component using the rings. The different components of the triad and rings are displayed
in Figure 12-50.

To move a component along the X direction, press and hold the left mouse button on the X
arm; the select cursor will be replaced by the move cursor. Use the left mouse button to drag
the selected component in the X direction. Similarly, you can select the Y or the Z arm and
drag the cursor to move the component in the Y or Z direction.

To rotate the component about the X-axis, move the cursor on the rotate around the X-axis
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Rotate around
Y oaxis

Woaxis

Rotate around
L axis

Figure 12-50 Triad with rings

ring and drag the cursor; the component will be rotated through an angle of 90-degrees. To
rotate the component through an angle less than 90-degrees, press and hold the left mouse
button on the ring, drag the cursor away from the triad and again drag the cursor to rotate
the component.

You can also move a component in the XY plane. To do so, select the XY wing of the triad and
drag the cursor to move the component. To move the component in the YZ plane, select the
YZ wing of the triad and drag the cursor to move the component. Similarly, by selecting the
ZX wing and dragging the cursor, you can move the component in the ZX plane.

If you select the sphere in the center of the triad and invoke the shortcut menu, various
options will be available. These options are discussed next.

Show Translate XYZ Box

The Show Translate XYZ Box option available in the shortcut menu is used to display the
Translate XYZ box. You can use this box to specify the value of the X, Y, and Z coordinates of
the destination where you need to place the selected component. Specify the X, Y, and Z
coordinates in the respective edit boxes and then choose OK from the box. When you move
the component by dragging, the values of the X, Y, and Z spinners will change automatically.

Show Translate Delta XYZ Box

The Show Translate Delta XYZ Box option available in the shortcut menu is used to display
the Translate Delta XYZ box. Use this box to specify the incremental value by which you
need to move the selected component in the X, Y, or Z direction. Set the incremental value in
the X, Y, or Z edit box and then choose OK from the box.

Show Rotate Delta XYZ Box

The Show Rotate Delta XYZ Box option available in the shortcut menu is used to display the
Rotate Delta XYZ box. You can use this box to specify the incremental value by which the
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selected component will rotate in the X, Y, or Z direction. Set the incremental value in the X,
Y, or Z edit box and then choose OK.

Align with Component Origin

This option is used to align the triad and the rings to the origin of the selected component.

Align with Assembly Origin

This option is used to align the triad and the rings to the origin of the assembly.

Align to

This option is used to align the triad and the rings to a selected component or a feature.
TUTORIALS

Tutorial 1

In this tutorial, you will create all components of the Bench Vice and then assemble them.
The Bench Vice assembly is shown in Figure 12-51. The dimensions of various components
of the assembly are given in Figures 12-52 through 12-55. (Expected time: 2 hrs 45 min)

Figure 12-51 Bench Vice assembly

The following steps are required to complete this tutorial:

a. Create all components in individual part documents and save them. The part documents
will be saved in the \My Documents\SolidWorks\c12\Bench Vice folder.

b. Open the Vice Body and Vice Jaw part documents and define the mate references in
both part documents, refer to Figures 12-56 and 12-57

c. Create anew assembly document and open all part documents. Place the first component,
which is the Vice Body. Now, drag and drop the Vice Jaw in the assembly document. It
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Figure 12-54 Views and dimensions of the Vice Jaw

will automatically assemble with the Vice Jaw because the mate references are already
defined in both part documents, refer to Figures 12-58 and 12-59.

Drag and drop the Jaw Screw in the assembly document and apply the required mates,
refer to Figures 12-61 through 12-66.

Next, analyze the assembly for degrees of freedom of the components.

After analyzing the assembly, apply the required mates to constrain all degrees of freedom,
refer to Figures 12-67 and 12-68.

Next, assemble the Clamping Plate, refer to Figures 12-69 through 12-72.

Next, assemble the Oval Fillister using the feature-based mates, refer to Figure 12-73.
Similarly, assemble the other components.

Save the model.

Creating the Components

1.

Create all the components of the Bench Vice assembly as separate part documents. Specify
the names of the documents, as shown in Figures 12-52 through 12-55. The files should
be saved in the folder \My Documents\SolidWorks\c12\Bench Vice. Make sure that the Bench
Vice is your current folder.
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Creating the Mate References

In this tutorial, you need to assemble the first two components of the assembly using the
mate references. For assembling the components using the mate references, first you
need to create the mate reference. Therefore, you need to open the part documents in
which you will add the mate references.

Choose the Open button from the Menu Bar toolbar.

Double-click on the Vice Body; the vice-body part document is opened in the SolidWorks
window.

Choose Reference Geometry > Mate Reference from the Sketch CommandManager;
the Mate Reference PropertyManager is invoked. The selection mode in the Primary
Reference Entity selection box is active.

Select the planar face of the model, as shown in Figure 12-56, as the primary reference;
the selected planar face is highlighted.
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10.

11.

12.

13.

14.

Select the Coincident option from the Mate Reference Type drop-down list in the Primary
Reference Entity rollout; the selection mode in the Secondary Reference Entity
selection box is active.

Select the planar face of the model, as shown in Figure 12-56, as the secondary reference;
the selected face is highlighted.

Select the Coincident option from the Mate Reference Type drop-down list in the
Secondary Reference Entity rollout; the selection mode in the Tertiary Reference Entity
selection box is active.

Select the planar face of the model, as shown in Figure 12-56, as the tertiary reference.
The selected face is highlighted.

Tertiary
reference

Secondary
reference
Primary
reference

Figure 12-56 Fuces to be selected as mate references
Select the Parallel option from the Mate Reference Type drop-down list in the Tertiary
Reference Entity rollout.

Enter Vice Mate Reference as the name of the mate reference in the Mate Reference
Name edit box available in the Reference Name rollout.

Choose the OK button from the Mate Reference PropertyManager.

Open the Vice Jaw part document.

Similarly, create the mate reference in the Vice Jaw part document. The faces to be
selected as reference are shown in Figure 12-57. For both the part documents, enter the

same name in the Reference Name rollout.

Close all part documents, except Vice Body.sldprt and Vice Jaw.sldprt, if they are opened.
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Figure 12-57 Fuces to be selected as mate references

Assembling the First Two Components of the Assembly
After creating the mate references in the part documents, you need to assemble the
components. To do so, you need to start a new SolidWorks assembly document.

1. Start a new SolidWorks assembly document; the Begin Assembly PropertyManager is
invoked automatically and the names of components that were opened, are displayed in
the Open documents selection box.

2. Select the Vice Body from the Open documents selection box; the preview of the Vice
Body is displayed along with the component cursor.

It is recommended to place the first component of the assembly at the assembly origin.

3. Choose the OK button from the Begin Assembly PropertyManager; the first component
is placed coincident to the origin.

4. Change the current view to isometric.

Next, you need to place the second component in the assembly. As discussed earlier, the
second component of the assembly, which is the Vice Jaw, is assembled with the Vice
Body using the mate references.

5. Choose the Insert Components button from the Assemble CommandManager;
the Insert Component PropertyManager is invoked and the names of | _r%
components, which were opened, are displayed in the Open documents selection
box.

6. Select the Vice Jaw from the Open documents selection box; the preview of the Vice Jaw
is displayed in the drawing area.
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When you move the cursor close to the Vice Body in the assembly document, the preview
of the Vice Jaw assembled after applying the mates with the Vice Body is displayed in the
assembly document.

7. Place the component at the required location. The mates specified in the mate references
are applied between the Vice Jaw and the Vice Body.

Figure 12-58 shows the second component being placed in the assembly document
and Figure 12-59 shows the isometric view of the Vice Jaw assembled with the Vice Body.
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Figure 12-58 Second component being placed

8. Before proceeding further, close the part document windows of all the parts that are
placed in the assembly document.

& Tip. The mates that are defined in the mate reference are applied to the components
3 when you place the components in the assembly. You can view the mates applied to
both components by expanding the Mates node from the FeatureManager

design tree of the assembly document.
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Figure 12-59 Vice Jaw assembled with the Vice Body

Assembling the Jaw Screw
Now, you need to place the Jaw Screw in the assembly document.

1. Choose the Insert Components button from the Assemble CommandManager. |F%

2. Choose the Browse button in the Part/Assembly to Insert rollout; the Open dialog box
is displayed.

3. Double-click on the Jaw Screw to open its part document; the preview of the Jaw Screw is
displayed in the drawing area.

4. Click anywhere in the drawing area to place the Jaw Screw, as shown in Figure 12-60.

Next, you need to add the assembly mates to assemble the components placed in the
assembly.

Figure 12-60 Jaw Screw placed in the assembly document

5. Press and hold the ALT key and then select the face from the location shown in
Figure 12-61.
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6. Drag the Jaw Screw to the hole in the Vice Body, as shown in Figure 12-62; the Jaw Screw
appears transparent and the select cursor is replaced by the smart mates cursor. Also, the
symbol of the Concentric mate is displayed below the cursor.

Face to be
selected

Figure 12-61 Face to be selected Figure 12-62 Jaw Screw being dragged

7. Release the left mouse button at this location; the Mate pop-up toolbar is displayed | @ l
and the Concentric button is chosen by default, which suggests that the |
Concentric mate is the most appropriate mate to be applied. Choose the Add/

Finish Mate button from the Mate pop-up toolbar. Figure 12-63 shows the Jaw Screw
assembled in the Vice Body.

Figure 12-63 The Concentric mate applied between the Jaw Screw and the Vice Body

Next, you need to apply the Coincident mate between the planar faces of the Jaw Screw
and the Vice Jaw.

8. Choose the Mate button from the Assemble CommandManager to invoke the % |
Mate PropertyManager. —

9. Rotate the assembly view and select the face of the Vice Jaw, as shown in Figure 12-64.
Next, select the face of the Jaw Screw, as shown in Figure 12-65.
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10.

Faceto be
selected

Face to be
selacted

Figure 12-64 Fuce lo be selected

Figure 12-65 Face lo be selected

As soon as you select the faces, the Mate pop-up toolbar is invoked with the |
Coincident button chosen and the preview of the assembly with the coincident |£ I
mate is displayed in the drawing area.

Choose the Add/Finish Mate button from the Mate pop-up toolbar. The assembly after
adding the Coincident mate is displayed in Figure 12-66.

Figure 12-66 Assembly afler applying the Coincident mate to the Jaw Screw

In real world, there are two types of assemblies. The first is the fully defined assembly in
which all degrees of freedom of all components are restricted. The other type of assembly
is that in which some degrees of freedom of the components are left free so that they can
be moved or rotated. These types of assemblies are used for the mechanism, about which
you will learn in the next chapter.

After adding the Coincident mate, you need to move the assembly to analyze the degree
of freedom of the components in the assembly. After analyzing the components of an
assembly, you need to add the mates to constrain that degree of freedom.



Assembly Modeling-1I 12-41

11. Select the circular face of the Jaw Screw using the left mouse button and drag the cursor.
You will notice that the Jaw Screw is rotating about its axis and is moving along the X axis.
Also, it is forcing the Vice Jaw to move along the X axis. Although, this degree of freedom
of the Vice Jaw and Jaw Screw needs to be left free so that the assembly can function in
the mechanism, but in this chapter, you need to restrict this degree of freedom so as to
create a fully defined assembly.

12. Select the two faces, one of the Vice Body and the other of the Jaw Screw, as shown in
Figures 12-67 and 12-68.

Face to be
selected

Face to be
selected

Figure 12-67 Fuce lo be selected

Figure 12-68 Face to be selected

13. Choose the Distance button from the Standard Mates rollout; the PropertyManager
changes to the Distance 1 PropertyManager. Set the value in the Distance spinner to 10.

14. Choose the OK button from the Distance 1 PropertyManager to again display the
Mate PropertyManager.

15. Expand the FeatureManager design tree displayed in the drawing area and select the
Top Plane. Now, expand the Jaw Screw node from the FeatureManager design tree and
select the Top Plane; the Mate pop-up toolbar is displayed.

16. Choose the Angle button from the Mate pop-up toolbar.

17. Set the value in the Angle spinner to 45 and choose the Add/Finish Mate button from
the Mate pop-up toolbar.

18. Choose the OK button from the Mate PropertyManager to exit.

Assembling the Clamping Plate

Next, you need to assemble the Clamping Plate with the assembly.

1. Invoke the Insert Component PropertyManager and choose the Browse button to invoke
the Open dialog box. Open and place the Clamping Plate in the drawing area.
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o

Rotate the assembly such that the bottom face of the assembly is displayed, as shown in
Figure 12-69.

©°

Select the Clamping Plate using the right mouse button and drag the cursor to rotate it,
as shown in Figure 12-70.

Figure 12-69 Rotated assembly Figure 12-70 Clamping Plale afler rotating

a

Apply the Concentric mate between the two cylindrical faces of the clamping plate and
the two holes of the Vice Jaw, refer to Figure 12-71. You may have to move the Clamping
Plate after applying the first mate.

o

Move the Clamping Plate by dragging. Now, apply the Coincident mate between the
faces of the Clamping Plate and the Vice Jaw, as shown in Figure 12-72.

Concentricmate
to be applied

Concentric mate.

to be applied Coincident mate

to be applied

Figure 12-71 Fuces to be selected to apply mate — Figure 12-72 Faces to be selected to apply mate

6. Similarly, assemble the Screw Bar, Base Plates, and Bar Globes. The assembly after
assembling all these components is shown in Figure 12-73.

Assembling the Remaining Components
Next, you need to assemble the Oval Fillister, Set Screw 1, and Set Screw 2. These fasteners
are assembled using the feature-based mates.

1. Open the part documents of Oval Fillisters, Set Screw 1, and Set Screw 2.
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Figure 12-73 Assembly after assembling the Vice Body, Vice Jaw,
Jaw Screw, Screw Bar, Clamping Plate, Base Plate, and Bar Globes

2. Choose Window > Tile Horizontally from the Menu Bar menus to rearrange the windows.

3. Select the Revolvel feature from the FeatureManager design tree of the Oval Fillister
part document. Drag the cursor to place the component in the assembly, as shown in
Figure 12-74.

4. Drop the component at the hole for the Oval Fillister.
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Similarly, assemble Set Screw 1 and Set screw 2 using the feature-based mates. Use the
TAB key on the keyboard to reverse the direction. The rotated view of the assembly
after assembling Set Screw 1 and Set Screw 2, is shown in Figure 12-75.

Figure 12-75 Viewing the final assembly from the bottom

5. Choose the Save button to save the assembly with the name Bench Vice in the folder |My
Documents\SolidWorks\c12\Bench Vice.

Tutorial 2

In this tutorial, you will create all components of the Pipe Vice and then assemble them. The
Pipe Vice assembly is shown in Figure 12-76. The dimensions of various components of this
assembly are given in Figures 12-77 and 12-78. (Expected time: 2 hrs 45 min)

Figure 12-76 Pipe Vice assembly
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Figure 12-78 Views and dimensions of the Screw, Handle, Moveable Jaw, and Handle Screw

You need to create all components of the Pipe Vice assembly as separate part documents.
After creating the parts, you will assemble them in the assembly document. Therefore, in
this tutorial, you need to use the bottom-up approach for creating the assembly.

The following steps are required to complete this tutorial:

Create all components in the individual part documents and save them. The part
documents will be saved in \My Documents\SolidWorks\c12\Pipe Vice.

Place the base at the origin of the assembly.

Place the Moveable Jaw and the Screw in the assembly. Apply the mates between Moveable
Jaw and the Screw, refer to Figures 12-79 through 12-81.

Assemble the Screw with the Base.

Place the other components in the assembly and apply the required mates to the assembly,
refer to Figure 12-82.
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Creating the Components

1.

Create all components of the Pipe Vice assembly as separate part documents. Specify the
names of the files, as shown in Figures 12-77 and 12-78. The documents should be saved
in the folder \My Documents\SolidWorks\c12\Pipe Vice.

Inserting the First Component in the Assembly

4.

After creating all components of the Pipe Vice assembly, you need to start a new SolidWorks
assembly document.

Start a new SolidWorks assembly document; the Begin Assembly PropertyManager is
displayed, by default.

Choose the Browse button from the Part/Assembly to Insert rollout to display the Open
dialog box. Double-click on the Base.

Choose the OK button from the Begin Assembly PropertyManager to place the Base
origin coincident to the origin of the assembly document.

Change the view orientation to isometric.

Inserting and Assembling the Moveable Jaw and the Screw

After placing the first component in the assembly document, you need to place the
Moveable Jaw and the Screw in the assembly document. After placing these components,
you need to apply the required mates.

Choose the Insert Components button from the Assemble CommandManager. @
Then, choose the Keep Visible button from the PropertyManager. Now, invoke |_r
the Open dialog box by choosing the Browse button from the Part/Assembly to
Insert rollout.

Double-click on the Moveable Jaw. Place the component anywhere in the assembly
document such that it does not interfere with the existing component.

Similarly, place the Screw in the assembly document and choose the OK button from the
Insert Component PropertyManager. Figure 12-79 shows the Moveable Jaw, Screw, and
Base placed in the assembly document.

First, you need to assemble the Screw with the Moveable Jaw. Therefore, you need to fix
the Moveable Jaw.

Select the Moveable Jaw from the drawing area or from the FeatureManager design
tree. Right-click to invoke the shortcut menu.

Choose the Fix option from the shortcut menu; the Moveable Jaw is fixed and you cannot
move or rotate it.
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10.

11.

12.

13.

Figure 12-79 The Moveable Jaw, Screw, and Base placed in the
assembly document

Invoke the Move Component PropertyManager and choose the SmartMates button
from the Move rollout. Double-click on the lower most cylindrical face of the Screw; the
Screw appears transparent.

Drag the cursor to the hole located on the top of the Moveable Jaw. Release the left
mouse button as soon as the concentric symbol is displayed below the cursor. Choose
the Add/Finish Mate button from the Mate pop-up toolbar.

Select the Screw and move it up so that it is not inside the Moveable Jaw.

Right-click in the drawing area and choose Clear Selections to clear the current selection.

Rotate the assembly and double-click on the lower flat face of the Screw; the Screw appears
transparent.

Again, rotate the model and select the top planar face of the Moveable Jaw. The Coincident
mate is applied between the two selected faces. Choose the Add/Finish Mate button
from the Mate pop-up toolbar.

Choose the OK button from the SmartMates PropertyManager. Figure 12-80 shows the
Screw after applying the mates.

Next, you need to assemble the Screw and the Moveable Jaw with the Base.

Select the Moveable Jaw, invoke the shortcut menu and then choose the Float option
from it; the Moveable Jaw and the Screw assembled to it can be moved.
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14.

15.

16.

17.

Press the ALT key, select the cylindrical face of the Screw and move toward the hole
created on the top face of the Base to add the Concentric mate.

Invoke the Mate PropertyManager and select the front planar face of the Moveable Jaw
and the front planar face of the Base.

Choose the Parallel button from the Mate pop-up toolbar and choose the Add/Finish
Mate button to add a Parallel mate between the selected faces.

Next, select the faces. as shown in Figure 12-81.

Faces to be
selected

Figure 12-80 The Screw assembled with the
Moveable Jaw

18.

19.

20.

21.

Choose the Distance button from the Mate pop-up toolbar and set the value in the
Distance spinner to 35.

Choose the Add/Finish Mate button from the Mate pop-up toolbar and then choose the
OK button from the Mate PropertyManager.

Similarly, assemble the other components of the Pipe Vice. Figure 12-82 shows the final
Pipe Vice assembly.

Choose the Save button to save the assembly document in the |My Documents\
SolidWorks\c12\Pipe Vice folder.
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Figure 12-82 Final Pipe Vice assembly

SELF-EVALUATION TEST

Answer the following questions and then compare them to those given at the end of this
chapter:

1.

The bottom-up assembly design approach is the traditional and the most widely preferred
approach of assembly design. (T/F)

In the top-down assembly design approach, all components are created in the same
assembly document. (1/F)

The Coincident mate is generally applied to make two planar faces coplanar. (17F)

The most suitable mates that can be applied to the current selection set are displayed in
the Mate Selections rollout in the Mate PropertyManager. (I/F)

Feature-based mates are applied only to the components that have cylindrical
features. (T/F)

Pattern-based mates are used to assemble the components that have a circular pattern
created on the circular feature. (T/F)

Choose the button from the Assemble CommandManager to invoke the
Rotate Component PropertyManager.

The option available in the Rotate drop-down list is used to rotate the selected
component by an incremental angle about the specified axis.
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9. The mate is generally used to align the central axis of one component with
that of the other.

10. The option available in the Move drop-down list is used to move the
component along the direction of the selected entity.

REVIEW QUESTIONS

Answer the following questions:

1. The names of the selected entities are displayed in the selection box of the
Mate Component PropertyManager.

2. Choose from the Menu Bar toolbar to place a component in the assembly
document.
3. Select the option from the Move drop-down list to move the component

dynamically along the X, Y, and Z axes of the assembly document.

4. The button available in the Standard Mates rollout is used to make the two
selected entities normal to each other.

5. The option is used to specify the coordinates of the origin of the part where
the component will be placed after moving.

6. Ifyou are adding the feature-based mates using the features that have a conical geometry,
then there must be a face adjacent to the conical face of both the features.

7. In SolidWorks, which of the following is the most widely used method of adding the
mates to the components in the assembly?

(a) Smart Mates (b) Mate PropertyManager
(c) By dragging from part document  (d) None of these

8. Which button is used to make the Mate Component PropertyManager available after
applying a mate to the selected entities?

(a) Help (b) OK
(c) Keep Visible (d) Cancel

9. Which of the following options in the Rotate drop-down list is used to rotate the component
with respect to the selected entity?

(a) Along Entity (b) Selected Edge
(c) Reference Entity (d) None of these
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10. Which option is used to specify the coordinates of the origin of the part where the
component will be placed after moving?

(a) To XYZ Position (b) Reference Position
(c) Along Entity (d) None of these

EXERCISE

Exercise 1

Create the Plummer Block assembly, as shown in Figure 12-83. The dimensions of the
components of this assembly are shown in Figures 12-84 through 12-86
(Expected time: 1 hr)

Figure 12-83 Plummer Block assembly
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Answers to Self-Evaluation Test
1. T,2. T, 3. T, 4. T, 5. T, 6. T, 7. Rotate Component, 8. By Delta XYZ, 9. Coincident,
10. Along Entity



